
Overview of J-Term Pro

J-Term Pro is the most advanced Telnet client currently available for the Microsoft ® Windows® Operating 
Systems.    

Some of the many features of J-Term Pro are:
· Multiple Simultaneous Connections
· Scripting to automate common tasks
· ANSI Color
· All common emulation modes
· Smart cut / copy / paste
· Full customization of colors
· Customizable Key mapping
· FTP client and server
And much, much more!

Such advanced customization, and usability is available in only one telnet client - J-Term Pro!



Getting Started

When you first run J-Term Pro you will see a window with the J-Term logo.    In order to connect to a telnet 
server you will need to create a new connection.    You do this by clicking "Connection Manager" on the 
"Managers" menu (Figure 1.1).
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Create a new connection (explained in detail in the Connection Mananger Help topic).    Once your new 
connection is created you can click on it in the list found in the Connection menu section of the File menu.

Once you are connected you can start using Telnet by typing commands such as:
ls (lists files in the directory)
rm (deletes a file)
cp (copies a file)
mkdir (makes a new directory)
uname -a (tells you the Operating System version)



Command Line Options

J-Term Pro allows you to specify options on the command line.    Using the -s command line switch you can 
specify a script to be executed when J-Term loads.    For example:

Jtermpro.exe -s myscript.txt

You can also specify a connection name (or any number of connection names).    These connections will be 
made when J-Term Pro loads. 

Finally, specifying -q on the command line will open the Quick Connect dialog when J-Term Pro opens.

NOTE: any command line arguments that contain a space should be surrounded by quotes:
Jtermpro.exe "my web site" "my shell account" -s "my script.txt"



What is Telnet?

Telnet is an application that allows you to login to another computer on the Internet.    Most computers that 
allow Telnet logins use the UNIX Operating System.    Telnet allows you to use many Internet programs 
without needing to download them to your own computer.    

Telnet has an interface similar to DOS (command line).    You type your commands into the telnet window and
the remote computer responds by telling you something, or running the program you wish.

Telnet is a very old protocol and most of the Internet protocols such as IRC, FTP, WWW use a very similar set 
of protocols (generally based upon the Telnet protocol) to provide additional services to users of the Internet.

Most telnet servers provide you with a place to make directories, and store files, which can be incredibly 
useful for backing up your important documents.

Telnet accounts are often refered to as "Shell" Accounts.



Managers Overview

J-Term Pro uses Managers to organize all of your settings.    This section of the help file explains what each 
manager does, and how you can access it.

The first way to get to the managers is from the Managers menu (Figure 1.1).    The second way is via the 
toolbar buttons.

Figure 1.1

Connection Mananger

 

The Connection Manager is used to create / edit / delete and configure all of your telnet connections

Palette Mananger

The Palette Manager is used to configure the color palette you wish to use in your connection settings

Keylist Mananger

The Keylist Manger is used to configure the keys sent to the server when you press keys on your keyboard

Global Event Mananger

The Global Event Manager is used to edit or create scripts to be executed when certain events occur

Script Mananger

The Script Manager is used to edit or create various scripts which can be run by right clicking on an open 
connection, or from the "Quick run a script" menu item on the Tools menu.

Add-In Mananger

The Add-In Manager is used to create items on the Add-Ins menu and to write the scripts that are executed 
when you click those menu items



Connection Manager

The connection manager is the dialog box you use to create new Telnet connections (figure 1.1).

Figure 1.1

To create a new connection click the "Add New" button.    This will create a new connection with a default 
name of New Connect X (where x is the number of the new connection).

If you wish to rename your connection you simply select it in the list and right click.    Select Rename from the
menu and a rename dialog will pop up.

Next you need to edit your new connection.    Do this by clicking "Edit".    This opens the    "Connection Editor" 
(figure 1.2). 

Figure 1.2

Choosing Your Telnet Server: You should define the name of the computer you wish to connect to.    This 
usually looks like someserver.someISP.com.    You enter this into the Remote Host editbox found at the top of 
the window.

Configuring Your Server Port: Most telnet servers use port 23 as default.    You can leave the port field 
with this default number unless your Internet Service Provider has told you otherwise

Setting Up Your Rows: Screen rows is the number of lines across that J-Term Pro will display your 
connection with.    You can change this number if you prefer, but generally the default will suffice.



Setting Up Your Columns: Screen Columns is the number of lines down that J-Term Pro will display.    You 
can change this number but again, generally the default should suffice.

Choosing Your Emulation: Emulation.    There are 3 types of available emulation: ANSI; VT100; and VT220. 
ANSI emulation allows J-Term Pro to display your connection using the default colors of the remote host.    Not 
all hosts support ANSI emulation.    VT100 is the older standard in emulation that supports use of the arrow 
keys and is a standard monochrome display type.    If you have problems with ANSI you should try connecting
with VT100 emulation.      VT220 is similar to VT100 but uses a slightly different keylist.    (NOTE: you can also 
specify your keylist with the KeyList dropdown box).

Setting Break and Reset sequences: You can change the default break and reset sequences (these 
define the action J-Term performs when it sends a reset or break) by modifying the values of both the "Break 
Sequence" and "Reset Sequence" edit boxes.    This is optional and the defaults should suffice for most if not 
all connections.

Setting Your Color Palette: You can change the color palette your connection uses by selecting a different 
palette from the "Palette" dropdown list.

Editing Your Keys: You can change your keylist by choosing from the "KeyList" dropdown box.    Both the 
keylist and Palettes can be configured from their managers (found on the Managers menu).

Changing Colors: By clicking the "Color Settings" button you can change the way your screen looks when 
using your specific connection.    These settings are active only for the connection you are editing and use 
the color palette you have chosen.    More information.

Changing Fonts: If you wish to use a special font, click the "Default Font" button.    This opens the standard 
Windows® Font Dialog.    Make your selection and click OK or cancel if you decide not to change your 
settings.    NOTE: J-Term Pro Font Dialogs will display only Fixed size fonts, as variable sized fonts are not 
suitable for terminal emulation.

Connection Events: J-Term pro lets you script many portions of your connection’s behavior.    By clicking on 
"Event Handlers" you can write your own code to control this on a connection by connection basis.    For more
information on scripting refer to the J-Term Pro Scripting Tutorial.

A connection specific event (when enabled) will override any global events, unless the global even is called 
from the connection specific event.

More information.

Setting Common Options: Options Section.    Each option and its effect is listed below.

· Add Carriage Return - This forces J-Term to add an extra carriage return character when you 
hit enter. 

· Add Line Feed - This forces J-Term to add an extra Line Feed character when you hit enter
· Local Echo - This causes commands you type to be repeated back to you
· Monochrome - This will set your connections display to monochrome (2 color).
· Force Line Draws - Some UNIX programs draw boxes on your screen, this option will ensure 

that programs will display properly.

To set the default characteristics for all new connections, select "Connection Defaults" from the File Menu.



Palette Manager

The Palette Manager (figure 1.1) lets you configure the color settings for J-Term Pro.    Once the Palette 
manager is open, click New to create a new, editable palette.    To change any of the colors in the palette 
simply double click the color and select a new one from the color dialog that appears.

To rename your palette, simple right click in its name and select "Rename".

Figure 1.1



Keylist Manager

The Keylist Manager allows you to change the keys, which get sent to the telnet server when you hit a button
on your keyboard.    To modify, or create a new keylist, select "Keylist Manager" on the Managers menu.    The 
first dialog you see (figure 1.1) allows you to delete or edit the current keylists or create a new keylist.    

Figure 1.1

To create a new keylist click "New".    This creates a new entry (to rename this entry right click it and select 
"Rename" from the menu.    Next click "Edit". This opens the Keyboard editor (figure 1.2).    To change the 
default value of a key simply click it.    Type the key you wish to send when that letter is clicked, into the Send
editbox.    Once you have finished making a change, click "Accept" which will save your modification. When 
you have finished making all changes, click "Done".

Figure 1.2

Example: If you wish to set a sequence to send when you press Ctrl-Q click the Ctrl button on the keylist, 
then click the Q button.    In the Send edit box you can type the keys you wish to send.    Click Accept.

Special keys you can use in the Send edit box:
· \b - sends backspace
· \e - sends escape
· \t - sends Tab
· Keys preceded by ^ - sends Control+Key



Global Event Manager

J-Term Pro allows you to script many of the client/server events which occur between itself and the Telnet 
server.    Using the Global Event Manager you can write your scripts (for more information on scripting see 
the J-Term Pro Scripting Tutorial).

All events you script here fire for every connection unless the connection has it's own specific events 
scripted.

Figure 1.1

If you write a script for any or all of the following events, you need to make sure you check the "Enabled" 
box.    If you check this box the script will be executed, otherwise it will not be.

The Global Event Manager has 6 events you can edit:
· OnBeforeConnect - occurs just before a connection is attempted
· OnConnect - occurs when a connection is made
· OnDisconnect - occurs when a connection is lost
· OnWatch - occurs when text found in the connection's "Watch list" (see J-Term Pro Scripting 

Tutorial) is matched.
· OnStart - occurs when J-Term Pro starts
· OnStop - occurs when J-Term Pro stops



Script Manager

The script manager (figure 1.1) is used to write scripts, which you can use by right clicking on an open 
connections tab, or from the "Quick Run Script" menu item on the Tools menu.

Figure 1.1

When you open the Script Manager you need to click the first button of the toolbar (or select "New" from the 
File menu) which will create a new editor window.    You simply type your script into the window and save it - 
making it available for use in J-Term Pro.

NOTE: You should always start your script with begin and finish it with end;
Eg:
Begin
ShowMessage('This is my first script');
End;

For scripting help see the J-Term Pro Scripting Tutorial.

File Menu:

New Script

This menu item and button will open a new editor window in the Script Manager which you can use to write 
your scripts.

Open Script

This menu item and button will open a script you have already made so you can modify it.



Save

This menu item and button will save the current script you are editing to a file of your choice.

Save As

This menu item will let you resave the current document to a different file.

Close Script

This menu item and button will close the current editor tab.    Be sure to save changes before closing.

Print Script

This menu item and button will print your current editor's script on your default printer.

Exit Script Manager

This menu item closes the J-Term Pro Script Manager

Edit Menu:

Cut

This menu item and button cuts the currently selected text to the clipboard.    This removes it from your 
editor and makes it available to other windows programs.

Copy

This menu item and button copies the currently selected text to the clipboard.    This makes it accessible to 
other windows programs without deleting it from the current editor.

Paste

This menu item and button pastes the current clipboard contents into your editor at the current cursor 
position.



Run Menu:

New Script

Clicking this button or menu item will run the script you have written in your current editor.    This is an 
excellent way to test scripts as you write them.

Help Menu:

Contents

This menu item and button will load the J-Term Pro scripting help

Index

This menu item will let you search the J-Term Pro scripting help via keyword searching

Getting Started with J-Term Scripting

This menu item will show the first topic of the J-Term Scripting help.



Add-in Manager

Addins make it possible for you to add your own menus to J-Term Pro and to write the scripts which are 
executed when you click the menu item.

You use the Add-In Manager (figure 1.1) to design your menu and to test it.    When you have made a menu 
item, you can click on it in the bar at the top of the Add-In Manager.    Clicking the new menu item will open 
an editor window that you can use to write your script.

Figure 1.1

You use the Add Sibling button to add a top level menu item, or an item on the same level as the one you 
have currently selected.    You use the Add Child button to add a new sub-menu item to the currently selected
sibling.

To rename a menu item, slowly double click the item in the menu editor and type in the new name.    

Menus you create with the Add-In Manager are available on the main menu bar of J-Term Pro. 



Connection Events

J-Term Pro allows you to script many of the client/server events which occur between itself and the Telnet 
server.    Using the Connection Event Manager you can write your scripts (for more information on scripting 
see the J-Term Pro Scripting Tutorial).    These scripts affect only the connection you are currently editing.    If 
you wish to make a script for all connections use the Global Event Manager.

Figure 1.1

The Connection Event Manager has 4 events you can edit:
· OnBeforeConnect - occurs just before a connection is attempted
· OnConnect - occurs when a connection is made
· OnDisconnect - occurs when a connection is lost
· OnWatch - occurs when text found in the connection's "Watch list" (see J-Term Pro Scripting 

Tutorial) is matched.

If you write a script for any or all of the above events, you need to make sure you check the "Enabled" box.    
If you check this box the script will be executed, otherwise it will not be.

NOTE: Global events do not fire if a corresponding connection event is configured for them, unless called with
the "GlobalEvent" function.    For more information on the "GlobalEvent" function refer to the J-Term Pro 
Scripting Tutorial. 



Quick Connect Menu

The Quick Connect menu opens a small dialog prompting you for a server name and port name.    Type in the 
name of an existing connection (or select it from the drop down list) or type in a qualified DNS name for the 
Telnet Server you wish to connect to and click OK.    This will open a connection to that server.



Connect Menu

When you have created one or more connections, they are listed as sub items of the Connect Menu.    To 
open one of those connections simply select it from the list.



Disconnect Current

Clicking this menu item will disconnect the current Telnet Session.    All other sessions are not affected by 
this.



Print Screen

Clicking this menu item prints your current session's contents.    You can also configure the printer font and 
general options.



Printer Font

This menu item displays a standard Font dialog that you can use to change your printer's font.    



Setup Printer

Clicking this item opens the default printer setup dialog.    With this dialog you can change the alignment, 
size and other properties of your printer.



Eject Printer Page

Clicking this item will force your printer to eject the current page it is printing.



Connection Defaults

This option allows you to configure the default display settings of all new connections (figure 1.1).    For 
further reference see the Connection Manager.

Figure 1.1



Exit

Clicking this menu item will close J-Term Pro.    All current sessions will close when you click this menu item.





Copy

Selecting Copy will copy the text you have selected in your current session to the clipboard so you can paste 
it (Shift-Insert) into another application.

To select text hold the mouse button down at the start of the text you want to copy, and move the mouse to 
the end of the text you want to copy.    Take the mouse button off and click the copy button, or select Copy 
from the edit menu.



Paste

Selecting paste will put the contents of the clipboard into your current telnet session window.

This is useful if you need to put a lot of text from your Windows machine into an editor on the Telnet server.



Send Break

Clicking this menu item will send the break string defined in the connection manager to the current 
connection.



Reset Terminal

Clicking Reset Terminal will send the reset sequence defined in the connection manager to the current 
connection.



Show Button Bar

This option toggles the button bar visible / invisible.      This allows you to increase your overall screen space.





Modify Colors

Clicking Modify Colors will open the Connection Text Colors (figure 1.1) dialog.    You can use this option to 
change your connections colors on the fly.

Figure 1.1



Modify Font

This option allows you to change your session's font on the fly.    NOTE: Only fixed size fonts are allowed as 
variable sized fonts cause display problems with terminal emulation.



Change Keylist

This option allows you to change your current session's keylist on the fly.    This can be especially useful if you
find you are having problems with your current emulation once you are connected.



Force Line Draws

This option enables you to toggle the line draws state.    Forcing line draws allows J-Term Pro to use the 
appropriate font characters when a program you run on the server tries to draw boxes and shapes on your 
screen.



Quick Run A Script

This menu item allows you to run scripts you have created with the Script Mananger. 

When you select this item, a standard windows OpenDialog will appear.    Simply select your script and click 
OK.



Log To File

This option lets you specify a file in which to save and log your Telnet session.



FTP Client

FTP means File Transfer Protocol.    FTP is the most popular Internet protocol for sending and receiving files.    

Because of the popularity of FTP and the fact that FTP is often used hand in hand with Telnet to upload files 
to a shell account, J-Term Pro includes full FTP serving and client capabilities.    

When you want to connect to an FTP server you must load the FTP client.    Clicking the FTP client menu will 
display the Connection Editor (figure 1.1).
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Fields:

Connection Name - the friendly name you wish to give to your connection.
Host - this is the internet name or address of the FTP server you wish to connect to
User ID - this is your username (if you have one) or anonymous for most public FTP sites
Password - this is your password (if you have one) or your email address for most public FTP sites
Initial Local Dir - this is the directory on your hard drive you wish to open when you connect
Initial Remote Dir - this is the directory to open on the server when you connect

Once you have finished editing your connection, click "Save" to keep the connection information for future 
use.    You can also create new and delete connection information with the "Create New" and "Delete" 
buttons.

To connect to the FTP server you have chosen, click Connect.    This will open the FTP client window (figure 
1.2)



Figure 1.1

The left panel deals with your computer, and the right panel contains the directories and files on the remote 
computer.    To move files between computers use the two buttons in the middle of the two panels.

Both panels have a set of buttons:

Mkdir - this button creates a new directory
DelCurDir - this button deletes the directory you are currently viewing
Del - this button deletes the currently selected file(s)
Rename - this button renames the currently selected file
Refresh - this button refreshes the current directory list
Exec (* local directories only) - this button loads the file you have selected

You can right click in the two panels to get a large number of extra options in a popup menu.



FTP Server

J-Term Pro comes with an FTP server to allow other users (or yourself) to connect to your computer to 
download and upload files.    Clicking this menu item will start the FTP server (figure 1.1).    When you close 
the FTP server window a small icon appears in the system tray (bottom right hand side of your task bar) 
which you can use to access the server in windows.

Figure 1.1

To connect to your FTP server you simply use an FTP client like the one in J-Term Pro.    You enter your own 
computers Internet address or name and connect. 

If you wish to have added security you can select the Access Control menu item from the server's File menu.  
This opens the Access Control dialog (figure 1.2). 

Figure 1.2

To give users access simply click Add User.    This opens the Add User dialog (figure 1.3).    Enter the 
username and password for the new user and add the directory you wish them to have access to (this 
includes all subdirectories).      Using the Edit and Delete buttons you can also modify and remove user 
information.



Figure 1.3

FTP servers use a special port which users can access to get onto your FTP site.    By default this is port 21.    
You can modify this port by selecting the "Select Listening Port" menu item on the File Menu.    

If you wish to keep a file of all connections to your server, you can set logging on via the "Log To File" menu 
item on the File menu.





Contents

Clicking Contents on the help menu will display the contents of this help file.



Index

The Index item of the help menu displays a list of keywords for this help file, which you can use to find the 
help you need.



Scripting Help

This menu item opens the J-Term Scripting Tutorial to help you write your scripts.



About

This menu item displays information about J-Term pro.




